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1 Copyright Notice, Acknowledgements 

No parts of this work may be reproduced in any form or by any means - graphic, electronic, or 
mechanical, including photocopying, recording, taping, or information storage and retrieval 
systems without the written permission of the publisher and author. All rights reserved. 

1.1 Trademarks 

Products that are referred to in this document may be either trademarks and/or registered 
trademarks of the respective owners. The publisher and the author make no claim to these 
trademarks. 

1.2 Disclaimer 

Information furnished is believed to be accurate and reliable. However, the publisher and the 
author assume no responsibility, consequential or otherwise, for errors or omissions or use of 
such information contained in this document or from the use of programs and source code that 
may accompany it. In no event shall the publisher and the author be liable for any loss of profit 
or any other commercial damage caused or alleged to have been caused directly or indirectly by 
this document. 
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2 Introduction 

SimpleTerm is an advanced serial port test, simulation and data analysis tool. It will allow you to 
view and send (all 256) ASCII/Extended-ASCII (non-printable) data in an easy to read colour 
coded sequence. It is a high performance C++ application designed to run on almost all PCs 
running Microsoft® Windows 9X, Windows 7 to Windows 11(32 & 64 Bit). 
 
SimpleTerm is a mature, stable product used by professional technicians, engineers and 
software developers as a development aid and debugging tool for RS232/serial port related 
projects. 
 
SimpleTerm will work with the serial/COM ports provided by your operating system. Physically, 
these ports will be male RS232 SUB D9 interfaces in most cases. However, it is also possible to 
use SimpleTerm for other communication standards such as RS485 and RS422, which have a 
different electrical design to RS232 but follow the RS232 communication mechanism. Also 
supported are “Virtual COM” ports presented by e.g. USB to Serial adaptors & Bluetooth™ 
Serial Port Profile devices. The quality of support is limited only by the quality / compliance of the 
device drivers in emulating a normal COM port. This manual will only refer to RS232 based 
connections as this is the basis for the other standards mentioned above. 
 

2.1 Features List 

A brief list of some of the features included in SimpleTerm are given below: 
 

• Colour coded ASCII terminal, hexadecimal and “mixed mode” data views 

• Standard 110 to 3 Megabaud plus custom baud rates 

• Supports COM1 to COM256 and special virtual COM ports. 

• Designed for Microsoft® Windows 9X, Windows 7 – Windows 11(32 & 64 Bit). 

• Advanced “Macro List” support with Import/Export facility 

• High performance, large display matrix (up to 1000 lines by 140 columns) 

• “Visual Scripting” feature for rapid test, automation or device simulation  

• Powerful fixed or variable length sequence detector with wildcard support 

• Data entry using the PC keyboard – similar to a terminal emulator 

• Selection View pane for alternative radix/notation views. 

• Ability to extract, process or save to file selection data 

• Import and Export SimpleTerm Settings Profiles 

• Notation Converter 

• Integrated feature rich notepad 

• Cyclic Redundancy Checking (CRC).  

• MODBUS RTU message framing and CRC generation support. 

• RS232 control signal monitoring using “Virtual LEDs” 

• Capture to file and send data from files 

• Online changing of line settings and display font 

• Copy & paste data to other applications in RTF (Rich Text Format) 

• Built in search and colour print capability 

• Reference ASCII table 

• RTF data exporting – saved files load in Microsoft® WordPad, Word etc. 

• Supports “Virtual COM” ports (e.g. as presented by USB to Serial adaptors) 

• Advanced COM port lister 
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2.2 What's new? 

New in v.5.7 
1) Modernised, clean GUI. 
2) Message Display for enhanced test automation, timestamping support and general user 
notification use via the Macro List / Scripting feature.  
3) "Message Display" macro type with a collection of useful function subtypes. 
4) Very useful functions and expressions can be embedded in the "Send Data" field for the 
"Send Data Sequence" macro type to create complex sequences/packets that even combine 
prompted user input and autocalculated CRC. Ability to generate random or sequential test 
data. See new [+] button in Macro List pane to quickly create examples. 
5) "New line before special char" + Play System Sound action. See Settings->Display 
Settings. 
6) Bug fix for rare "Wait for Data" sequence Macro List issue. 
7) Search facility for Macro List and other user interface enhancements. 
 

 
New in v.5.6 
1) Enhanced COM port listing with more information - see Comms->Find Available COM 
Ports. No need to go to device manager. Can double click within COM port drop down box to 
view . 
2) CRC with data offset support e.g. via inline script within Data Send Sequence macros. 
3) New "Loop To Folder" macro. 
4) For automatically starting a Macro List on application start and looping, the following 
features have been added: 
Added new settings option - see Settings->General tab: "Run Macro List on startup or 
drag&drop". 
Added new macro list item: "Jump to Start" - moves execution to start of macro list. 
5) Allowing of drag and drop support of separate macro lists (*.stml) or full settings profiles 
(*.ini or *.stp). 
6) Renamed Import Profile to "Load Settings Profile" 
Renamed Export Profile to "Export Settings Profile" 

2.3 System Requirements 

Operating system:  
Microsoft® Windows 9X, XP, Vista, Windows 7 – Windows 10 (32 & 64 Bit), Windows 11  
 
Minimum recommended hardware requirements:  
Intel Pentium / AMD processor or equivalent, 500Mhz or faster, 256 MB RAM, one or more 
available COM ports. Note that additional cables may be required for connecting any equipment 
to be tested. SVGA monitor and graphics card capable of at least 256 colours. 
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2.4 User Interface 

A screenshot of the application is shown below in Figure 1. The user interface of SimpleTerm is 
divided into eight main sections – a brief description of each is given here: 
 
Figure 1: SimpleTerm – Running in Windows® XP. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Toolbar  
Most common functions may be selected from the toolbar by clicking on the icons. Placing the 
mouse cursor over each icon will display a ‘hint’ window indicating its function. 
 
Quick Configuration Panel 
This may be used to rapidly configure the serial port line settings. With the exception of the Port 
(COM port) setting the line settings may be changed while online/connected. 
 
Quick Entry Pane 
This is used to quickly type in a sequence of data (sometimes referred to as a string) for 
transmitting via the COM port. The data can contain normal ASCII data or special/extended 
characters using an escape character to define characters in hexadecimal. 
 
Communication Screen 
This is the input/output display screen. It displays the out going and incoming communication 
from the serial port. The font used for displaying the data is changeable. The communication 
screen may also be referred to generally as the screen. 
 
Control Signal Panel 
This panel contains “Virtual LEDs” to display the state of the RS232 control lines. The LEDs for 
the output handshaking lines from the PCs serial port (DTR and RTS) are “clickable” using the 
mouse and therefore may be used as switches to toggle the state of these lines manually. 
 
 
 

    Communication Screen 

 Control Signal Panel 

Status Bar 

Toolbar 

Quick Entry Pane 

Macro List Pane 

Quick Configuration Panel 
 

      Selection View Pane 
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Status Bar 
Additional information about the communication status, errors, input/output byte count, screen 
selection or the current settings may be shown in the status bar. 
 
Macro List / Visual Script Pane  
Common data sequences or actions may be stored as macros within this pane. Macro items are 
grouped within folders (in a similar way to files and folders in the Windows Explorer application). 
The macro items may be executed in sequence once or continuously as a “Visual Script”. 
 
Selection View Pane 
This provides an alternative representation of any data selected within the Communication 
Screen. This option is only available in the advanced display modes: Hexadecimal or Mixed 
(ASCII/Hexadecimal). 

3 Features and Usage 

SimpleTerm displays all incoming serial port data and all outgoing serial port data sent via the 
keyboard or sent using the “Quick Entry Pane” in its communication screen. Incoming and 
outgoing data are displayed using different colours. SimpleTerm has scroll functionality that 
allows the viewing of received data that has scrolled off the screen. The logged data on 
SimpleTerm’s communication screen may be copied to the clipboard, printed or exported as a 
RTF (Rich Text Format) file. These files may then be loaded in Microsoft® WordPad, Word & 
other programs that support RTF for further processing. 
 
SimpleTerm processes serial data streams containing any ASCII characters from 0 – 255 
decimal (when operating in 8-bit mode). 
 
Note that keys typed within the communication screen may be sent directly to the serial port. 
Alternatively, any character from 0 - 255 decimal may be inserted into SimpleTerm’s 
communication screen (for transmission) using the “Alt + key” sequence. Hold down the "Alt 
Key" on your keyboard and press the numbers (0 followed by the 3-digit ASCII value in decimal) 
for the character you want on your numeric keypad. For example, “Alt + 0065” will result in the 
ASCII character ‘A’ being inserted into the communication screen. 

3.1 Display Modes, Data Formatting and Colour Code 

SimpleTerm handles all the serial port data in an 8 bit-oriented way. Every sequence of serial 
data consists of one or more 8 bit characters. 
 
Display Modes 
The serial port data is displayed in the communication screen in various colour coded display 
mode options. The data viewing modes for the communication screen include basic “ASCII 
Terminal”, advanced “Mixed (ASCII, hexadecimal)” and “Hexadecimal” only modes. 
 
“ASCII Terminal” text mode is provided for simple terminal emulation functionality and does not 
show characters in hexadecimal notation unlike with the other modes. Also note that a “non-
printable” character such as null character (00 hexadecimal) is sent and received but is 
displayed on screen as a SPACE character unlike with the other modes. This is because a null 
character does not have a displayable character assignment in the ASCII character set. 
 
Any ASCII/8-bit character can be displayed in “Mixed (ASCII, hexadecimal)” and “Hexadecimal” 
modes using hexadecimal notation where required. 
 
Data Formatting and Colour Code 
Incoming and outgoing data are displayed in various colours as described here. 
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Output data: 

• Standard “printable” ASCII characters are shown on-screen in black. 

• Special/extended characters (00h to 31h and 7Fh to FFh) characters are shown  
on-screen in blue and are enveloped in left and right angle brackets e.g. <hh> where 
hh are the two hexadecimal digits of the 8-bit character. 
 
Note – all outgoing data is in black when running in “ASCII Terminal” mode. 

 
Input data: 

• Standard “printable” ASCII characters are shown on-screen in green. 

• Special/extended characters (00h to 31h and 7Fh to FFh) characters are shown  
on-screen in red and are enveloped in left and right angle brackets e.g. <hh> where 
hh are the two hexadecimal digits of the 8-bit character.  
 
Note – all incoming data is in green when running in “ASCII Terminal” mode. 

 
Here is an example of the data formatting and colour coding used for outgoing data when 
running in “Mixed (ASCII, hexadecimal)” mode: 
 
OUTPUT<0D> 

 
For the above example, standard ASCII characters “OUTPUT” were typed in using the 
keyboard. After this the ENTER key was pressed resulting in the display of a “special” character 
in hexadecimal enveloped in “<>”. 
 
Here is an example of the data formatting and colour coding used for incoming data when 
running in “Mixed (ASCII, hexadecimal)” mode: 
 
INPUT<0D> 

 
For the above example, standard ASCII characters “INPUT” followed by a CR (CARRIAGE 
RETURN) character of value 0D hex were received at the opened COM port. 

3.2 Com Port Initialisation and Connection 

The words “open”, “connected” and “online” may be used thought this document to refer to the 
state of a COM port as being selected, initialised and “open” for communication. 
 
Line Settings 
All common line settings are configurable via the “Quick Configuration Panel”. SimpleTerm 
supports standard baud rates from 110 to 230400 which are configurable while online. Custom 
baud rates may be typed in the baud rate field when offline (disconnected from the COM port). 
Data bits, parity and stop bits are also configurable online. Standard COM port numbers and 
“Virtual COM” ports 1 to 256 are supported on SimpleTerm. “Virtual COM” ports may be 
presented by devices such as our Tronix USB to Serial adaptors and Bluetooth Serial Port 
Profile devices. 



 
 

  

SSiimmpplleeTTeerrmm  ––  UUsseerr  GGuuiiddee  
 
 

SimpleTerm Manual v3.2.doc, © Copyright 2022 Tronisoft - Printed in England, UK - All Rights Reserved. 8 

 

 
 
Connect / Disconnect 
You can open a COM port for communication by clicking on the Connect / Disconnect icon in the 
“Toolbar” or alternatively by selecting the menu item “Comms->Connect”: 

 
 
The COM port number and its settings are as displayed in the “Quick Configuration Panel”. Note 
that the hardware control signals RTS and DTR are always asserted on connection to enable 
reception of data. 
  
Note that certain functions and menu items are disabled until a valid COM port has been opened 
for communication.  
After the COM port is opened, the Connect / Disconnect icon in the “Toolbar” changes its image 
to that shown below. This image depicts a cable connection to a serial port and signifies the 
state of the COM port as open for communication. Clicking on this icon will toggle the connection 
state back again so that the COM port is closed. 
 

 
 
Note that after the COM port has been opened the ”Comms->Connect” menu item is disabled 
and the ”Comms->Disconnect” menu item becomes enabled for selection. 
 
CAUTION: it is good practice and more importantly to avoid system instability, to always 
disconnect (if connected) before physically removing devices which present a Virtual COM port 
to your PC/Laptop. These may be USB-Serial adaptors for example for which the emulated 
COM port disappears on physically removing the device. 

3.3 Data transmission from file / Log to file 

Send file … 
 
Click on the menu item “Transfer->Send file… ” and select the file to transmit via the serial port. 
All data within the file is sent through the port and a progress bar is used to show the progress of 
the transfer and the status bar shows any additional information -including the file size and 
percentage of transfer completed. The menu item will change during the transfer of a file to 
“Transfer->Stop Sending”. This will allow the data transfer to be stopped or cancelled. 
Alternatively, hitting the End key on the keyboard may also be used to cancel / stop data 
transfers. 
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Tip: when transferring binary or data files containing 8-bit data, ensure that the COM port has 
been initialised for 8-bit communications, that is, make sure that the “Data bits” in the “Quick 
Configuration Panel” is set to 8. 
 
Special Send File… 
 
This function is a more flexible version of the “Send file…” option above. 
 
Data within a file may be sent through the serial port (when connected) with the option of 
sending multiple times and with an accurate inter-character delay. A dialog box is presented to 
set the number of times to send a file by using the “Repeat Send Counter” field and an inter-
character delay by setting the “Character Delay” field. Then click on the “Open File” button to 
bring up another dialog box for finally selecting the file to send. 
 

 
 
Log to File…    (raw data logging) 
 
SimpleTerm can capture/save outgoing & incoming serial data into a file. 
 
Click on the menu item “File->Log To File…” and enter the location and filename of the file to 
save incoming serial data to. 
 
The menu item will change during capture to “File->Stop Logging” so that the data logging may 
be stopped. Alternatively, hitting the End key on the keyboard may also be used to cancel / stop 
data capture. 
 
The following data is logged:  
 
Any incoming serial data bytes will be logged. All outgoing serial data bytes will be logged 
except data sent from files e.g. using the “Transfer->Send File…” menu item. 
 
Tip: when capturing binary data or data files containing 8-bit data, ensure that the COM port has 
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been initialised for 8-bit communications, that is, make sure that the “Data bits” in the “Quick 
Configuration Panel” is set to 8. 

3.4 Control Signal Panel 

This panel contains “Virtual LEDs” to display the state of  the RS232 control lines when 
connected/online. The LEDs turn bright green when the RS232 control lines are asserted. 
 

 
 
The right hand side of the panel monitors the PCs serial port input signals CTS, DSR, RI and 
DCD. The panel also contains an indicator which flashes briefly (bright green) when a “break” 
condition is detected on the serial communications line. 
 
The left hand side of the panel contains the output handshaking lines RTS and DTR which may 
be controlled manually if “Flow Control” is set to none. These signal lines are asserted by default 
(LEDs bright green) but can be switched off by clicking on the respective LEDs using the mouse 
or by using function key keyboard shortcuts F7 and F8 respectively. Similarly a break condition 
may be set by clicking on the LED labelled “BRK” or using the keyboard shortcut F9. 

3.5 Quick Entry Pane 

This is used to quickly type in a sequence of data for transmitting via the COM port. Insert data 
for transmission in ASCII or in hexadecimal using the escape character ‘\’ in the form ‘\hh’ where 
hh are two hexadecimal digits. 
 

 
 
Click on the Send button on the right hand side (or press the Insert key) to actually send the data 
to the serial port. The data can be sent repeatedly by setting the “repeat send counter” field (to 
the left of the Send button) to a value greater than zero. If set to zero then the data will be sent 
continuously until the Stop button is pressed (or the End key is hit). 
 
Escape Sequences 
 
Note that the following escape sequences for inserting characters are valid (values in 
hexadecimal): 
 

\hh  Any 8-bit character in hex notation where hh are two hex       

digits (in either uppercase or lowercase). 

\n  0a hex (Line feed) 

\r  0d hex (Carriage Return) 

\t  09 hex (Horizontal Tab) 

\\  5c hex (Backslash) 

 
For example to send "TEST", Carriage Return and a Line Feed character then try: 
TEST\0D\n 
 
Keyboard Shortcuts  
 
Insert – send data. 
End – stop sending data. 
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3.6 Find 

The “Find” dialog box is displayed when the menu item “Edit->Find…” is clicked or alternatively 
click on the magnifying glass tool bar icon (shown top left here): 
 

 
 
You may search for specific words or characters displayed in the communication screen.  
 
To search, place the cursor on the communication screen to select the start position to search 
from. On the “Edit” menu, click “Find”. In “Find what”, type the characters or words you want to 
find, and then click Find Next. To find additional instances of the same text, continue to click 
Find Next. 
 

3.7 Data Exporting and Printing 

Copy 
SimpleTerm can copy serial data to the clipboard which can then be pasted into other 
applications such as word processors in colour if the RTF (Rich Text Format) is supported or as 
plain text into most text editors. 
 
First select the area of data to copy. Then use the menu item “Edit->Copy to Clipboard” to copy 
the text to the clipboard or alternatively, “right-click” on the communication window and select 
“Copy to Clipboard” from the pop-up (context) menu. 
 
The data can be pasted as plain text in a suitable text editor such as notepad or as RTF text in 
applications like Microsoft® Wordpad. 
 
Saving Screen Contents 
You can save the contents of the communication screen as a RTF file (.rtf extension) using the 
“File->Save Communication Screen (RTF)” or Save Communication Screen (RTF) As…” menu 
items. 
 
Colour Printing 
The on-screen data can be printed off in colour. Use the menu item “File->Print Setup…” to 
setup the printer and page settings then use  “File->Print” to print. 

3.8 New Session / Clear Screen  

The communication screen’s contents may be cleared using the menu item “Edit->New 
Session”. This also resets any screen, error message or character information on the status bar 
(such as the byte count). Only the running timer in the status bar (indicating the duration the 
COM port has been opened for) is not reset. 
 
To just clear the communication screen of data then use the menu item “Edit->Clear 



 
 

  

SSiimmpplleeTTeerrmm  ––  UUsseerr  GGuuiiddee  
 
 

SimpleTerm Manual v3.2.doc, © Copyright 2022 Tronisoft - Printed in England, UK - All Rights Reserved. 12 

Communication Screen” or click on the tool bar icon shown here: 
 

 

3.9 ASCII table 

 
 
An ASCII Table is provided for reference under the menu item“ Help->ASCII Table...”. ASCII 
characters 00-FF hexadecimal are displayed in various notations including decimal, hexadecimal 
and binary. The text within this window may be selected and copied to the clipboard. 

3.10 Settings Window 

This settings window is shown when the menu item “Settings->Configure…” is clicked or  
alternatively click on the following tool bar icon: 
 

 
This window is split into four tab separated sections for configuring the applications behaviour  
and display options.  
 
The three buttons at the bottom of the Settings Window allow any changes to the configuration 
to be applied temporarily (“OK” button), saved permanently to the configuration settings *.ini file 
(“Save Settings” button) or discarded (“Cancel” button). 
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3.10.1 General 
 
The first tabbed section “General” contains other miscellaneous options:  
 
Title Bar Text 
 

 
 
"Title Bar Text" - appends the title bar of the running copy of SimpleTerm with text of your 
choice. Can be useful for distinguishing your running instance of SimpleTerm as to which device 
you are testing. 
 
“Append COM port number” – this will show the COM port number of the connected device after 
the title bar text. Can be useful for distinguishing your running instance of SimpleTerm as to 
which COM port is being used for communications. 
 
Automatic Actions 
 

 
 
 
“Connect on startup” - if this item is ticked then on startup, SimpleTerm  
will attempt to automatically open the COM port (preset in the saved configuration settings). 
 
“Connect on keypress” - if this item is ticked then SimpleTerm will attempt to automatically open 
the COM port (preset in the saved configuration settings) when a key has been pressed within 
the communication screen. 
 
“Log & append data on startup (st_log.txt)” - if this item is ticked then SimpleTerm will attempt to 
automatically log data to a text file named “st_log.txt” within the users default “Documents” 
folder. e.g. “C:\Users\UserName\OneDrive - Company Limited\Documents\st_log.txt” 
 
“Run Macro List on startup or drag&drop) - if this item is ticked then SimpleTerm will attempt to 
automatically run the “Default Macro List” file or one that has been selected via drag and drop 
into one of the main SimpleTerm windows. 
 
Default Macro List 
 

 
 
“Default Macro List” – type in the filename here of the default Macro List file to load when 
SimpleTerm starts up (usually stmacros.stml). 
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View Panes 
 

 
 
“Display the Quick Entry Pane” – if this item is ticked, then the Quick Entry Pane is visible. 
 
“Display the Selection View Pane” – if this item is ticked then the Selection View Pane is made 
visible. However, the Selection View Pane is only available for the advanced Hex or Mixed 
(ASCII/Hex) display modes. Note that the number of bytes displayed on each line of the 
Selection View Pane can be set in the edit box shown left of “Selection View – Bytes Per Line”. 
 
 
3.10.2 Display Settings 
 
The second tab section (Display Settings) contains various settings to configure the display 
options of the communication screen:  
 

 
 
 
Display Mode Size & Font 
 
The data viewing options for the communication screen are available here via a drop down list. 
The selections of viewing modes include “ASCII Terminal”, “Mixed (ASCII, hexadecimal)” and 
“Hexadecimal” modes. 
 
The font used to display data on the communication screen may be changed by clicking on the 
button labelled “Font”. 
 
Lines / Columns - Display Matrix 
 
The communication screen displays data on a matrix of lines and columns. 
 
“Lines” - The number of lines to display in the communication screen (1000 maximum). 
 
“Columns” - The number of columns to display in the communication screen (140 maximum). 
 
“Adjust Columns To Screen Width” - the column width will be automatically adjusted as the 
application screen width is adjusted if this item is ticked. Leave un-ticked to enable the column 
width to be set manually. 
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Filters and Conversion 
 

 
 
“Show input only” – if this item is ticked then only incoming data from the opened COM port is 
displayed on the communication screen. 
 
“New line on CR” – if this item is ticked then a new line is inserted into the communication 
screen after a CARRIAGE RETURN character (0D hex) has been received. 
 
“New line on LF” – if this item is ticked then a new line is inserted into the communication screen 
after a LINE FEED character (0A hex) has been received. 
 
”TAB to spaces (“ASCII Terminal” mode only)” – TAB (09 hexadecimal) characters are replaced 
with space (20 hexadecimal) characters for correct display and alignment when running in ASCII 
(display) mode. Insert an integer between 1 and 12 for the number of spaces per TAB. 
 
"Allow CTRL+A, CTRL+C as Select All, Copy". This option if ticked will process CTRL+A and 
CTRL+C key sequences as "Select All" text or "Copy" text functions as is normally expected in a 
Windows™ environment. 
 
"New line before special character" option for display settings; allows message data separation 
for easier analysis of data formats in protocols. If ticked will insert a new line before the 
"special/custom" character specified using the drop down list to the right. A system sound may 
also be actioned for audible feedback if the “Play System Sound” option is ticked and a system 
sound type has been selected. 
 
3.10.3 Advanced 
 
The third section “Advanced” contains advanced options for flow control and file transmission 
block sizes. 
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“Flow control” - the following flow control options are supported: 
 

• None – the RTS/DTR line may be manually controlled using function keys F7/F8 
respectively. 

• RTS/CTS (hardware) flow control 

• DTR/DSR (hardware) flow control 
 
“Data Send Block Size (file transfers only)” - for efficient data transfer, the data from files may be 
sent to the serial port in blocks of bytes as opposed to one character after another.  
 
The following options are supported: 
 

• 1  - characters are sent one by one. This is inefficient but most responsive  
to flow control. 

• 25 - up to 25 characters are sent as a block of data. 

• Auto – the number of characters sent as a block is variable and is optimised to achieve a 
highly efficient data transfer rate. 

 
“Use Defaults” – this button, when pressed will set the flow control related settings to the 
defaults. 
 
 
Error Checking 
 
The second section “Error Checking” contains an Option to enable the checking of 
communication errors including parity errors. 
 

 
 
This option is dependent on the support of error checking within the COM port drivers installed 
for your serial port hardware e.g. some early (non-compliant) device drivers for USB to Serial  
adaptors did not support parity error checking. 
 
If a communication error is detected, a message is flashed in section 5 of the Status Bar (see 
section 3.12). The following messages may be displayed: 
 

Error Message Meaning 

UNDEFINED/RXPARITY The hardware detected a serious line error or multiple errors.  

Check baud, parity and data bits settings are set correctly for the 

communication device used. 

RXPARITY The hardware detected at least one parity error.  

Check parity setting is set correctly. 

FRAME The hardware detected a framing error.  

BREAK The hardware detected a break condition. 

 
 
 



 
 

  

SSiimmpplleeTTeerrmm  ––  UUsseerr  GGuuiiddee  
 
 

SimpleTerm Manual v3.2.doc, © Copyright 2022 Tronisoft - Printed in England, UK - All Rights Reserved. 17 

3.11 Load and Export SimpleTerm Profiles 

For rapid configuration when working with different devices or applications which require 
different configuration settings, SimpleTerm supports the saving of all display and serial port 
configuration information in named text files (with extension .stp) known as Profiles. Instead of 
reconfiguring all the communications and display settings every time a different RS232 / COM 
port device is used, simply import (a previously exported) SimpleTerm Profile. 
 
Note that SimpleTerm will still automatically load the default settings (within its  
SimpleTerm.ini configuration file) when it starts. Also note that only a reference to the location of 
the Macro List (normally a file called stmacros.stml) is saved in the profile settings (and not the 
actual Macro List data). 
 
Export Settings Profile 
 
Allows saving of the current SimpleTerm display and serial port configuration as a Profile so that 
the configuration may be recalled in future by importing the Profile. 
 
Generally export a Profile for each new device so all the information does not have to be in 
entered again in the future. 
 
To export a Profile:  

1) Adjust all the SimpleTerm display and configuration settings appropriate for the device 
or application used. Insert any data for saving within the Quick Entry pane. 

 
2) Click the menu item “Settings->Export Settings Profile…” and type the name of the 

Profile using the displayed “Save As” dialog box. 
 
Load Settings Profile 
 
Reconfigures SimpleTerm by loading the configuration settings from a Profile (of file extension 
.stp). This option also clears the communication screen after re-configuration by starting a new 
communication session. 
 
To load a Profile, click the menu item “Settings->Load Settings Profile…” and select a file using 
the displayed “Open” dialog box. 
 
Tip: another (perhaps faster way) to import a profile is to “drag & drop” a Profile file (of file 
extension .stp) into the “Communication Screen”. 

3.12 Status Bar and Byte Selection Information 

 
The status bar is a horizontal area at the bottom of the Communication Screen in SimpleTerm 
for providing additional user feedback and information about the communication status, errors, 
input / output byte count and screen selection. The bar is split into 5 sections and each section is 
described here in visual order from left to right: 
 
Section 1 displays a running timer indicating the duration for which the COM port has been in a 
connected state. 
 
Section 2 displays the line and column number (abbreviated to “Ln:” and “Col:” respectively) of 
the last character in a selection made in the communication screen’s display matrix. Also 
displayed is the number of selected display characters on screen (abbreviated to “Sel:”). 
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Section 3 displays the number of bytes recorded as having been sent (“Bytes Out:”) or received 
(“In:”) through the open COM port. A total of outgoing and incoming bytes is also displayed 
(“Total:”). Note that to reset the byte count (and also clear the screen) use the menu item “File-
>New Session”. 
 
Section 4 displays a selected byte within the communication screen in binary, decimal and 
hexadecimal notations. The selection must be for a single byte of data. To select a byte that is 
already displayed on screen in hexadecimal, both characters within the “<>” envelope must be 
selected as shown above. 
 

 
 
Section 5 may be used to display miscellaneous text for user feedback or to indicate 
communication errors. 
 

3.13 Calculate File CRC 

SimpleTerm provides a tool to calculate Cyclic Redudancy Check (CRC) values of files to help 
check the data integrity of files recieved and transimitted (e.g. via the serial port). The “File CRC” 
screen is displayed when the menu item “Tools->Calculate File CRC” is clicked. A dialog box is 
provided to select a file for processing. The results are displayed on a screen like the following.  
 

 
 
Popular/industry standard CRCs are calculated such as CRC16/ARC, CRC16(MODBUS), CRC-
CCITT and CRC32.  
 
The CRC's are computed using the following initial values and constants for the polynomial 
coefficients: 
 

CRC Type Initial Values (hex) Polynomial Coefficients (hex) 

CRC8                 0 8C 

CRC16/ARC      0 A001 

CRC16(MODBUS) FFFF A001 

CRC16(DNP)         0 A6BC 

CRC-CCITT/XMODEM 0 1021 

CRC-CCITT(FFFF)        FFFF 1021 

CRC-CCITT(1D0F ) 1D0F 1021 

CRC32                   FFFFFFFF EDB88320 
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3.14 Notation Converter 

This dialog box is shown when the menu item “Tools->Notation Converter” is clicked. Use this to 
convert data to and from decimal / hexadecimal notation. Conversion of binary to decimal and  
hexadecimal is also possible. 
 

 
 
The following example shows how to use this dialog box to view three different number  
representations (hex, decimal and binary) of hexadecimal F0: 
 

1) Type F0 in the Hex field. Notice that “240” is displayed in the Dec field and “1111 0000” 
is displayed in the Bin field. 

2) Similarly, (delete the current text) and type 240 in the Dec field. Notice that F0 will be 
displayed in the Hex field and “1111 0000” is displayed in the Bin field. 

3) Click the Close button to close the Notation Converter dialog box. 
 
Note:  

a) The label “(MSB)” indicates that the most significant bit in the binary representation is 
the leftmost bit within the “Bin:” field. 

b) “Bin Digits” label indicates the number of binary bits entered/displayed in the “Bin:” field. 
 
 

3.15 User Notes 

The User Notes is a simple yet feature rich single page notepad for storing handy notes or data 
during a debugging session for example. The “User Notes” screen is displayed when the menu 
item “Tools->User Notes” is clicked or alternatively click on the following tool bar icon:  

 

 
The notepad supports different font colour and style selections within the page and provides a lot 
of editing functionality similar to the Microsoft WordPad application. In addition, hyperlinks to 
internet web pages, email addresses or to files and folders on your computer may be stored. 
 
To save changes made in the User Notes screen press the “Save” button. When the notes are 
saved, the data is stored in a RTF (Rich Text Format) file called notes.rtf within SimpleTerm’s 
main directory. This file is importable into other applications that support RTF files including 
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Microsoft WordPad and Word if required. 
 
To close the User Notes screen press the “Close” button. 
 
User Notes - Toolbar and Pop-up Menu 
 
Toolbar icons from left to right and pop-up (context) menus are described here: 
 
Copy - copies text so you can paste it in another location by selecting the text and then 
clicking the Copy icon or alternatively “right-click” using the mouse and select “Copy” from the 
pop-up menu. 
 
Cut - cuts text so you can move it to another location by selecting the text and then clicking the 
Cut icon or alternatively select “Cut” from the pop-up menu. 
 
Paste – inserts text you have cut or copied by clicking in the document where you want to insert 
the text and then clicking the Paste icon or alternatively select “Paste” from the pop-up menu. 
 
Find – use to search for words or characters in your User Notes document by clicking the Find 
icon. To find additional instances of the same text, continue to click Find Next. 
 
Font Selector - changes a font type, style, size and colour by selecting the text that you want to 
change and then clicking the “Font Selector” icon to display the font options. 
 
Select All (Pop-up menu only) – selects all the text within the document. 
 
Clear All (Pop-up menu only) – clears the notes screen for a blank document. 
 
Paste In String Entry Pane (Pop-up menu only) – places selected text into the “String Entry 
Pane” ready for sending to the serial port. 
 
There are also icons/buttons (at the top right of the User Notes screen) for quick changes to the 
font and style of selected text. These include a drop down list of available system fonts and a 
“B”, “I” and “U” button for changing the style of selected text to bold, italic or underlined 
respectively. 
 
User Notes - Editing Keyboard Shortcuts  
 
Key Strokes   Shortcut to 

CTRL+A   Select all text 

CTRL+C   Copy 

CTRL+X                  Cut 

CTRL+V           Paste 

 

CTRL+F   Font selector 

CTRL+B   Bold 

CTRL+I   Italics 

CTRL+U   Underline 

 

Increment Font Size CTRL+} 

Decrement Font Size CTRL+{ 

 

CTRL+S or ALT+S    Save Changes 

CTRL+Z    Undo (multiple undo support) 

CTRL+Y    Redo (multiple redo support) 

ALT+C          Close (User Notes screen) 

F3             Find 
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3.16 Data Analysis - Selection View Pane & Communication Screen 

This Selection View Pane displays any selected data within the Communication Screen in 
different notations for advanced data analysis / debugging purposes. This option is only 
available in the advanced display viewing modes which show all 8-bit characters i.e. 
Hexadecimal or Mixed (ASCII/Hexadecimal) modes. 
 

 
 
The data can be represented in hexadecimal, decimal, octal, binary and character notations.  
Note that for the character “chr” option, non-printable control characters (less than 20 hex) are 
replaced with a ‘.’ for correct display. 
 
To select bytes that are displayed on screen in hexadecimal, both characters within the “<>” 
envelope must be selected. 
 
 “Right clicking” within the Selection View Pane provides a menu with options to customise the 
display colours / fonts, or copy, print and save the selected data to file: 
 

 
“Right clicking” within the Communication Screen provides a menu with options to process 
selected data or to save the raw data to file for performing custom data analysis.  
 
 
One built in data analysis function calculates industry standard CRC checksums on the selected 
data. To see this, select data, then right-click and choose menu item “Process/Extract Selection 
(Hex and Mixed Mode)->Calculate Checksums”. 
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This will bring up the Checksums Summary window as show here. 
 

 
 
 
Create Macros 
 
Rapid macros can also be created from the monitored on-screen data. Simply select the data 
and choose the required option such as the “Create Send Data Sequence Macro” to rapidly 
record a RS232 transaction as a macro for later playback using the “Visual Scripting” (e.g. in 
order to simulate a device or to create test sequences). 
 
For MODBUS RTU CRC appended message creation - send an example message to a COM 
port by using the String Entry Pane or typing message bytes starting with Slave ID. Then select 
on screen data and "right-click" to see "Process/Extract Selection" menu items. Select "Create 
Send Data Sequence Macro (with MODBUS RTU CRC)". 
 
For example: "\11\03\00\6B\00\03" will create "\11\03\00\k\00\03\76\87" where MODBUS RTU 
CRC is 8776 hex (byte order is swapped when transmitting calculated value hence last two 
characters are 76h and 87hex respectively). 
 

 
 
Similarly other macros can be automatically created from selection data for reuse later.  
See next section for more information on the Macro List / Visual Script pane. 
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3.17 Macro List & Visual Script Pane 

 
 
 
 
 
 
 
 
 
 
 
 
 
To aid in efficient and productive testing/debugging, a Macro List Pane is included (see the 
“View->Macro List Pane” menu item). “Macros” are a convenient way to store commonly used 
data or actions and can be saved to file. Saved macros can then be “executed” in order to 
transmit data through the serial port or carry out an action such as setting the RTS control signal 
active. 
 
Note that the Macro List (when saved) is stored in a file called stmacros.stml (as the default 
filename but other files may be loaded or imported). 

3.18 Creating Macros 

Ensure the “Show/Hide Macro Editor” button is pressed so that the “Macro List Editor” is visible.  
Macro items must be contained within a folder as shown below. This allows different sets of 
“macro items” to be contained within different folders. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Macro List  

Macro List Editor 

Macro items 

Folder 

Show/Hide 
Macro Editor 
button. 

Folder/Macro 
Item Properties  
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Macro List (Buttons) 
 
Here is a list of the standard Macro List buttons. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To create a new folder, press the “Add New folder Group” - button (a) shown above. Each folder 
must be given a name and optionally a description that will be displayed in the Macro List 
section. Hence the folder properties “Macro Name” and (optionally) “Description” should be filled 
in. 
 
The “Description” property is a free text field that is not used by the application for anything – it is 
simply provided for the users benefit e.g. to remind the purpose behind a macro or for any other 
additional information. The “Macro Type” property does not apply to folders and is not editable 
for a folder. 
 
A folder / macro items position can be changed using buttons (h) and (i) shown above. 
Alternatively macro items can be moved around using “drag and drop” actions. Macros within 
one folder can be moved to another using this technique. 
 
Macro List Editor (Buttons) 
 
When the macro list editor is visible (using button (d)) then further buttons become active and 
relevant. 
 
 
 
 
 
 
 
 
 
 
 
A macro can be marked for deletion using button (l), however the macro is only deleted when 
the Macro List is saved to file using the “Save Macro List” button (j).  
 
Modifications of the folder/macro item properties should be “applied” using button (n).  
Any modifications not “applied” can be undone / restored using button (m). 

(b) Add New Macro Folder Group 

(c) Add New Macro Item (Blank) 

(d) Show / Hide Macro Editor 

(e) Search within Macro List 

(h) Move Item Up 

(j) Save Macro List 

(a) Add New Macro Item (Example Selection) 

(f) Copy Macro Item 

(g) Paste Macro Item 

(i) Move Item Down 

(l) Mark Macro For Deletion 

(n) Apply Changes To Existing Macro 

(k) Erase / Clear All Data Fields 

(m) Undo / Restore Current Changes 
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To create a new macro item press button (c) shown above (“Add New Macro Item”). Again, fill in 
the “Macro Name” (and optionally the “Description”) property. Now set the “Macro Type” property 
as the name suggests to select the type of macro or action to store. Different macro types will 
provide different additional properties for filling in. 
 
 
List of Macro Types 
 
The list of currently supported macro types and their descriptions are shown in  
Appendix A – “List of Macro Types”. 
 

3.19 Macro List - Search 

An item within the macro list may be searched for using the “Search within Macro List” icon. 
 
This will help find a specific macro item. The search is case-insensitive within the name and 
description fields only for easy location of text without too many occurrences being found. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

3.20 Macro List Examples Creator 

Busy? Don't know how powerful SimpleTerm Gold is? With so many features in the latest 
version use the new [+] button in Macro List pane. This is an easy way to quickly create example 
macros as a starting point for your test scripts or to see how things are done. 
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3.21 Visual Scripting Feature 

There is a “Visual Scripting” feature to run/execute macros in sequence or repeatedly in a loop. 
This can be of great help for debugging or testing the robustness of RS232/RS485 based 
embedded systems. It is equally powerful for testing a variety of equipment by executing a 
sequence of macros/tasks written to exercise that equipment.  
 
Powerful sequence detection macros such as “Wait for Data Sequence” may also be specified to 
pause the script execution until a specific or even a non-specific variable length data sequence 
has been detected. This facilitates many test, simulation, or automation scripts to be created 
with ease and without having to resort to complex programming scripts. The list of currently 
supported macro types and their descriptions are shown in Appendix A – “List of Macro Types”. 
 
The Communication Screen (within the set screen matrix limits) displays all data sent using the 
“Send Data Sequence” macros. Bytes transferred using the “Send File” macro option are not 
displayed in order to maintain high speed operation. However, all data received from the serial 
port are displayed within the Communication Screen as usual. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
Visual Scripting Usage 
 
Ensure that SimpleTerm is online, that is, connected to a valid COM port with the correct line 
settings. Click to toggle the “Show/Hide Macro Editor” button such that the Macro List Editor 
section is not visible. 
 
Simply select the macro item/line to execute first. To execute just a single line item, press the 
button shown above as (d) or double-click on the selected macro item. To execute just a single 
line and then move to the next, press button (e). 
 
To execute all items starting from the current selection press button (a).  
To continuously execute all items starting from the current selection press button (b).   
 
To stop execution e.g. before completion or to stop a loop, then press button (c). 
 
To execute all line items within a selected folder only - press button (f).  
To continuously execute all items within a selected folder only - press button (g).  
 
Breakpoints may be set or removed using the toggle action (h).  
All breakpoints can be removed using button (i). 
 

(b) Loops items from selection  
within folder group 

(a) Play (run) all items from selection  
within folder group 

(c) Stop Execution 

(d) Run current item and stop 

(e) Run macro then move to next item 

(f) Execute all items starting from current 

(g) Loop through all items starting  
from current 

(h) Toggle/Set a breakpoint  

(i) Remove all breakpoints 
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3.22 Visual Scripting - "Message Display" window (new feature)  

A new Message Display window is now provided for enhanced test automation, time stamping 
support and general user notification. It may be used via the Macro List / Scripting feature. 
 

 
 
 
New "Message Display" macro type that uses the "Message Display" window with a collection of 
useful function subtypes. 
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3.23 Inline Scripting Feature (New feature) 

Powerful in-line functions and expressions can now be embedded inline in the "Send Data" field 
for the "Send Data Sequence" macro type to create complex sequences or protocol packets that 
even combine prompted user input and auto calculated CRC checksums. This provides the 
ability to generate random or sequential test data. This feature can be used in the macro list too 
for the "Send Data Sequence" macro type. 
 

 
 
As seen above in the Quick Entry Pane, anything as \$"expression" where expression is the in-
line scripting function such as get_crc(type, dataoffset).  
 
To try - insert the following in the Quick Entry Pane and press the Send button. 
123456789\$"get_crc(CRC16_MODBUS_RTU,0)"\$"start_newline()" 

 
or 
 
Temperature to set is:\$"get_text('Please tell me setpoint e.g. 22')"; 

 
or 
 
0x\$"char_to_hex(var_char_d)"\$"var_char_d+=1" 

 
CRC_TYPE can be: 
CRC8_DOW8, CRC16_MODBUS_RTU, CRC16_ARC,  

CRC16_DNP, CRC16_CCITT_XMODEM,  

CRC16_CCITT_FFFF, CRC16_CCITT_1D0F, CRC32 

 
Following functions are also available for advanced test use: 
 
rand_char() or rand_dec() or rand_hex() or e.g. use  

char_to_hex(var_char_x) where var_char_x is an 8-bit variable and one 

of var_char_a, var_char_b, var_char_c or var_char_d 

 
Operations on variables: 
Following simple operations on the (8-bit) variables exist. 
 
var_char_a=1        (assign 1 as value of var_char_a) 

var_char_a++        (increment  var_char_a by 1) 

var_char_a--        (decrement  var_char_a by 1) 
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var_char_a+=2       (increment  var_char_a by 2) 

var_char_a-=4       (subtract var_char_a by 4) 

var_char_a*=2       (multiply var_char_a by 2) 

 
e.g. 
Increment Variable A\$"var_char_a++" 
 
Other functions: 
start_newline()   - forces the start of new data displayed on the 
communication screen with a new line. 

 

4 Reference: Menu, Toolbar, Startup and Keyboard Shortcuts 

Most menu items have an ALT+key combination keyboard shortcut to select items within the 
menu. For example, to the menu item “File->New Session”, hold down the ALT key and then 
press the ‘f’ key for the file menu. Then press the ‘n’ key for New session. Other menu items 
have a Function key (F2-F10) associated and these are shown below. 

4.1 File Menu 

 
 
New Session 
Clears the display screen and resets the byte count in the status bar. 
 
Save Communication Screen (RTF) / Save Communication Screen As (RTF)...  
Saves the (colour coded) display data in the Communication Screen as a “Rich Text Format” file. 
 
Log To File… / Stop Logging 
Log/save serial data into a file (when connected). Useful for logging communication data within a 
specified file for capturing very large data logs or for permanent logs of capture sessions. If 
logging data is in progress, this menu item will change to state “Stop Logging” so that logging 
can be stopped. 
 
Print Communication Screen… / Print Setup...  
Setup the printer and print the contents of the communication screen. 
 
Exit (F10) 
Exit the SimpleTerm application. Keyboard shortcut: F10. 
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4.2 Edit Menu  

 
 
Copy 
To copy the text in the communication to the clipboard so that you can paste it in another 
application, select the text, and then on the “Edit” menu, click “Copy”. 
 
Find…(F3)  
Search for words or characters in the communication screen. Keyboard shortcut: F3. 
 
Select All 
You can select all text/characters in the communication screen at once by clicking “Edit”, and 
then clicking “Select All”. 
 
Clear Communication Screen (F4) 
Clear the contents of the communications screen. Note that this does not affect the byte count in 
the status bar (see File Menu->New Session). Keyboard shortcut: F4. 
 
Clear Status Bar Messages 
Clears any notification or error messages in the status bar. 

4.3 View Menu 

 
 
Display Mode 
This expanding menu item allows selection of the data viewing options for the Communication 
Screen. A sub-menu allows the selection between “ASCII Terminal”, “Mixed (ASCII, 
hexadecimal)” and “Hexadecimal” modes. 
 
Set Font…  
Set the font used for displaying data in the Communication Screen. 
 
Quick Entry Pane 
Toggle the display of the Quick Entry Pane.  
 
Macro List Pane 
Toggle the display of the Macro List / Visual Scripting Pane.  
 
Selection Pane (Hex and Mixed Mode) 
Toggle the display of the Selection View Pane. This option is only available in the advanced 
display modes: Hexadecimal or Mixed (ASCII/Hexadecimal). 
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Message Display 
Toggle the display of the Message Display Pane. The “Macro List” scripting functions can make 
use of this additional data viewing pane for powerful output messages including timestamps. 
 
Full Screen / Exit Full Screen 
Full Screen option maximises the SimpleTerm application window so it covers the full screen. 
Exit Full Screen option (shown when window is already maximised) restore the window to its 
previous size. Keyboard shortcut: ALT+ENTER (toggle action). 

4.4 Settings 

 
 
Configure…(F5) 
Show the Settings window for selecting the application program options  
(e.g. for display and other communication settings).  
Keyboard shortcut: F5. 
 
Save All Settings 
Save application settings (which include the serial port line settings) to a file called STGold.ini in 
the current directory. Note that the Macro List items are also saved but in a separate file called 
stmacros.stml (as the default filename but other files may be loaded or imported). 
 
Load Settings Profile 
Reconfigure SimpleTerm by loading the display and serial port configuration settings from a 
Profile (file extension .stp). 
 
Export Settings Profile 
Save the current SimpleTerm display and serial port configuration as a Profile (file extension 
.stp).so that the configuration may be recalled in future by importing the Profile. Note that the 
Macro List data items are not stored as part of the “Profile” - only a reference/location to the 
separate Macro List file is stored. 
 

4.5 Comms 

 
 
Connect 
Open the communication port selected in the Quick Configuration Panel and enable serial data 
transfer. Keyboard shortcut: F2 (toggle action). 
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Disconnect 
Close the communication port selected in the Quick Configuration Panel and enable serial data 
transfer. Keyboard shortcut: F2 (toggle action). 
 
Find Available Ports 
Will search for and list known COM ports within your system automatically refreshing the search 
until a specific COM port has been selected for use. Select a COM port and press "Connect to 
Port" or double-click the selection to connect to that COM port. Alternatively select a COM port 
and press "Disconnect/Change " to switch to a different COM port than one currently connected 
to but not connect to it automatically. 
 

 
 
Alternatively see your "Ports (COM & LPT)" section under the Device Manager (via the Control 
Panel) for a full listing of possible COM ports you can use and connect to. 

4.6 Transfer 

 
 
Send File… 
Send data within a file through the serial port (when connected). 
 
Special Send File… 
Send data within a file through the serial port (when connected) with the option of sending 
multiple times and with an accurate inter-character delay. 
 
Send Ctrl Char (00…0F hex) 
Transmit a control char within the range 00 and 0F hex to the serial port (when connected). 
 
Send Ctrl Char (10…1F hex) 
Transmit a control char within the range 10 and 1F hex to the serial port (when connected). 
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4.7 Tools 

 
 
Calculate Selection CRC… 
Perform Cyclic Redundancy Checks on selected data within the communication screen. 
 
Calculate File CRC… 
Perform Cyclic Redundancy Checks on files using this menu option. 
 
Notation Converter... 
Show the display of the Notation Conversion window. 
 
ASCII Table... 
Display a list of ASCII codes in various representations. 
 
User Notes... 
Show the User Notes window. Keyboard shortcut: F6. 

4.8 Help 

 
 
About SimpleTerm… 
Display information about your SimpleTerm application including version number and copyright 
information. 
 
Purchase Online (Secure Server)… 
For demonstration version of SimpleTerm an online link is provide to purchase software 
licenses. 
 
Register / Activate… 
Follow the on-screen instruction to activate your purchased software license for the computer 
you will use it on. 
 

4.9 Toolbar 

 
Icons from left to right: 
 
Connect / Disconnect 
Open / close the communication port. Keyboard shortcut: F2 (toggle action). 
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Find 
Search for words or characters in the communication screen. Keyboard shortcut: F3. 
 
Clear Screen 
Clear the contents of the communications screen. Keyboard shortcut: F4. 
 
Show Settings Window  
Show the Settings window. Keyboard shortcut: F5. 
 
User Notes 
Show the User Notes window. Keyboard shortcut: F6. 

4.10 Startup – Command Line Parameters 

SimpleTerm allows the filename of a Profile to be provided as part of the command line 
parameters. See section 3.11 “Import and Export SimpleTerm Profiles” for information about 
creating Profiles. 
 
Use the following syntax: 
 
stgold.exe profile.stp 
 
This will start up SimpleTerm with the settings defined within the file “profile.stp”. 
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Appendix A – List of Macro Types 

 
List of Macro Types 
 
The list of currently supported macro types and their description are shown here. 
 

Macro Type Additional property 1 Additional property 2 

“Send File” 
Send data to the 
serial port from a 
file. 

“Char Delay (ms)” 
Allows an intercharacter delay in milliseconds to 
be set. 

“File name”  
Set the location of the file to 
transmit from. Note: you can 
double click this property box 
to bring up an Open file 
dialog screen or press the 
button to the right of the 
property box. 

“Send Data 
Sequence”  
Sequence of data 
for transmitting via 
the serial port. 

“Char Delay (ms)” 
Allows short or long intercharacter delays to be 
set in milliseconds. 

“Data” 
Insert data in ASCII or in 
hexadecimal using the 
escape character '\' in the 
form '\hh' where hh are two 
hex digits. See section “3.5 
Quick Entry Pane” for a fuller 
description of the format.  
 
Note: you can double click 
this property box to bring up 
a help screen. 
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Macro Type Additional property 1 Additional property 2 

“Play Sound” 
This allows a 
sound to be output.  

“Sound / file” 
WAV files can be played by specifying a file 
name. If no sound card is present then a 
“beep:frequency” command can be typed in to 
emit sound via the computers internal speakers 
(assuming one exists). E.g. “Beep: 500” will emit a 
short sound of frequency 500 Hertz through the 
internal speakers. 
 

(N/A) 

“Control Signal” 
This allows the 
control of the serial 
port hardware 
signals states. 

“Signal State” 
Set to one of the following options or 
combinations: 
 
- RTS OFF 
- RTS ON 
- DTR OFF 
- DTR ON 
- RTS OFF, DTR OFF 
- RTS OFF, DTR ON 
- RTS ON, DTR OFF 
- RTS ON, DTR ON 
 
Note: signal states can only be changed if “Flow 
Control” option is set to “NONE”. 

(N/A) 

“Jump to Start” 
 

(N/A) 
 
This macro jumps execution to the top of the 
macro list and can be used to loop through a 
whole macro list again and again. 
 

(N/A) 

“Jump to Folder 
Start” 
 

(N/A) 
 
This macro jumps execution to the top of the 
current folder for looping through lines within the 
current folder. 
 

(N/A) 

“Loop to Folder 
Start” 
 

“COUNT” 
 
This will allow looping within a folder for a COUNT 
number of times. 
 
This can be used with the “Run All Items In 
Sequence” scripting button: 

 
 

(N/A) 

“(NONE)” 
 

(N/A) 
 
This is a “do nothing” macro. It can be used to 
provide a place marker or comment line (using its 
name and description property). 
 

(N/A) 

“Delay in ms” 
Pause execution 
for a period of time. 

Delay (ms) 
Set the number of milliseconds to pause for. 

(N/A) 
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Macro Type Additional property 1 Additional property 2 

“Wait for Data 
Sequence”  
Type in a 
sequence of data 
here to record as a 
"Wait for Data 
Sequence" macro. 
 

“Data” 
This macro is used for detecting data sequences 
within the serial data stream. On triggering  
on the data sequence, execution of the next 
macro item is allowed to proceed. 
 
Powerful "Wildcard" escape sequences are also  
supported for detecting variable length  
non-specific sequences. 
 
A wildcard is a special character that serves as  
a placeholder within a data sequence. It may be  
used for data sequences for which parts of the  
received data are unspecified in data and in  
length e.g. measurement readings reported by  
RS232 interface devices. 
 
Insert data in ASCII or in hexadecimal using the  
escape character '\' in the form '\hh' where hh  
are two hexadecimal digits. 
 
Note that the following escape sequences for  
inserting characters (in hexadecimal) or  
wildcards are valid: 
 
\hh  Any 8-bit character in hex notation where hh 
     are two hex digits (uppercase or lowercase). 
\n   0a hex (Line Feed) 
\r   0d hex (Carriage Return) 
\t   09 hex (Horizontal Tab) 
\\   5c hex (Backslash) 
\?   Wildcard: matches exactly one ASCII  
     character (any code between 0 and 255) 
\*   Wildcard: matches zero or multiple  
     characters. Note that this wildcard must  
     be combined with other characters or  
     wildcards for correct operation. 
 
Example 1:  
To look for simple data sequences such as  
"WEIGHT=" followed by three unknown digits  
then use the following: 
WEIGHT=\?\?\? 
 
Example 2: 
To look for a complex data sequence that starts  
with an STX (02 hex) and ends with an ETX (03 
hex) plus two unknown check digits, use the 
following: 
\02\*\03\?\? 
 

(N/A) 
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Macro Type Additional property 1 Additional property 2 

“Halt on Data 
Sequence”  
 Type in a 
sequence of data 
here to record as a 
"Halt on Data 
Sequence" macro. 
 

“Data” 
This macro is used for detecting data sequences 
within the serial data stream. On triggering on the 
data sequence, the opened COM port is closed 
and serial communications halted so that the data 
sequence remains visible within the 
communication window (e.g. for further analysis). 
 
Powerful "Wildcard" escape sequences are also 
supported for detecting variable length non-
specific sequences. 
 
A wildcard is a special character that serves as a 
placeholder within a data sequence. It may be 
used for data sequences for which parts of the 
received data are unspecified in data and in 
length e.g. measurement readings reported by 
RS232 interface devices. 
 
Insert data in ASCII or in hexadecimal using the 
escape character '\' in the form '\hh' where hh are 
two hexadecimal digits. 
 
Note that the following escape sequences for 
inserting characters (in hexadecimal) or wildcards 
are valid: 
 
\hh  Any 8-bit character in hex notation where hh 
are two hex digits (uppercase or lowercase). 
 
\n   0a hex (Line Feed) 
\r   0d hex (Carriage Return) 
\t   09 hex (Horizontal Tab) 
\\   5c hex (Backslash) 
\?   Wildcard: matches exactly one ASCII  
     character (any value between 0 and    
     255) 
\*   Wildcard: matches zero or multiple  
     characters. Note that this wildcard 
     must be combined with other 
     characters or wildcards for correct  
     operation. 
 
Example 1:  
To halt communication on finding a simple data 
sequence such as "ERROR=" followed by two 
unknown digits then use the following: 
ERROR=\?\? 
 
Example 2:  
To halt communication on a complex data 
sequence that starts with an STX (02 hex) and 
ends with an ETX (03 hex) plus two unknown 
check digits, use the following: 
\02\*\03\?\? 
 

(N/A) 
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Macro Type Additional property 1 Additional property 2 

“LOG: Start - Log 
To File” 

"Filename" 
 Log data on to file specified. 
 
As per "File->Log To File" menu item. 

(N/A) 

“LOG: Stop - Log 
To File” 
 

(N/A) 
As per "File->Stop Logging" menu item. 

(N/A) 

“COMMS: 
Connect” 
 

(N/A) 
As per "Comms->Connect" menu item. 

(N/A) 

“COMMS: 
Disconnect” 

(N/A) 
As per "Comms->Disconnect" menu item. 

(N/A) 

“COMMS: 
Reconnect New 
Settings” 

"Settings" 
Disconnect & reconnect from COM port with new 
COM port settings. 
 
e.g. "DEFAULT, 9600, 8, NONE, 1" 
or 
"COM2, 9600, 8, NONE, 1" 
 
The text "DEFAULT" indicates the use of the 
same COM port as specified already. 

(N/A) 

“COMMS: Set 
Line Settings” 

"Settings" 
Change default line settings without disconnecting 
from COM port; fast but for line settings only (will 
clear screen for new comms). 
 
e.g. "9600, 8, NONE, 1" 

(N/A) 
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Appendix B – ASCII Chart 

ASCII, the American Standard Code for Information Interchange, was developed in the 1960's as a 
standard 7-bit code for identifying letters, numbers, symbols, and special characters in the English 
language. It was later expanded (as Extended ASCII) to include additional symbols and foreign language 
characters. Standard ASCII consists of 128 characters, ranging from 0 to 127 which can be broken down 
into the following subgroups: 
 
0 to 31, 127: Control codes (includes null, backspace, line feed and others)  
32 to 47, 58 to 64, 81 to 86, 123 to 126: Punctuation marks, mathematical (and other) symbols 
48 to 57: Numbers 0 through 9   
65 to 80: Capital letters A through Z 
87 to 122: Lower case letters a through z 

 
Standard ASCII Chart 
 
The standard chart includes the ASCII character or control and their related decimal and hexadecimal 
values. Also shown are the control key sequences for the control codes. Note, to obtain codes 0 to 31, 
console Control Key is pressed while simultaneously pressing a Letter Key, e.g. ^J is the line feed 
character. Control Key subtracts decimal 64 (40h) from Letter Key pressed. 
 

 
Legend: ^Key - Control Key + Letter Key combination except 30 (1E hex) = Control +caret.

Dec Hex ^Key ASCII 

  

Dec Hex ASCII 

  

Dec Hex ASCII 

  

Dec Hex ASCII 

0 0 ^@ NUL (Null)   32 20 (Space) 64 40 @ 96 60 ` 

1 1 ^A SOH (Start of Heading) 33 21 ! 65 41 A 97 61 a 

2 2 ^B STX (Start of Text) 34 22 " 66 42 B 98 62 b 

3 3 ^C ETX (End of Text) 35 23 # 67 43 C 99 63 c 

4 4 ^D EOT (End of Transmission) 36 24 $ 68 44 D 100 64 d 

5 5 ^E ENQ (Enquiry) 37 25 % 69 45 E 101 65 e 

6 6 ^F ACK (Acknowledgement) 38 26 & 70 46 F 102 66 f 

7 7 ^G BEL (Bell) 39 27 ' 71 47 G 103 67 g 

8 8 ^H BS  (Backspace) 40 28 ( 72 48 H 104 68 h 

9 9 ^I HT  (Horizontal Tab) 41 29 ) 73 49 I 105 69 i 

10 A ^J LF  (Line Feed) 42 2A * 74 4A J 106 6A j 

11 B ^K VT  (Vertical Tab) 43 2B + 75 4B K 107 6B k 

12 C ^L FF  (Form Feed) 44 2C , 76 4C L 108 6C l 

13 D ^M CR  (Carriage Return) 45 2D - 77 4D M 109 6D m 

14 E ^N SO  (Shift Out) 46 2E . 78 4E N 110 6E n 

15 F ^O SI  (Shift In 47 2F / 79 4F O 111 6F o 

16 10 ^P DLE (Data Line Escape) 48 30 0 80 50 P 112 70 p 

17 11 ^Q DC1 (Device Control 1) 49 31 1 81 51 Q 113 71 q 

18 12 ^R DC2 (Device Control 2) 50 32 2 82 52 R 114 72 r 

19 13 ^S DC3 (Device Control 3) 51 33 3 83 53 S 115 73 s 

20 14 ^T DC4 (Device Control 4) 52 34 4 84 54 T 116 74 t 

21 15 ^U NAK (Negative Ack.) 53 35 5 85 55 U 117 75 u 

22 16 ^V SYN (Synchronous Idle) 54 36 6 86 56 V 118 76 v 

23 17 ^W ETB (End of Transmit Block) 55 37 7 87 57 W 119 77 w 

24 18 ^X CAN (Cancel) 56 38 8 88 58 X 120 78 x 

25 19 ^Y EM  (End of Medium) 57 39 9 89 59 Y 121 79 y 

26 1A ^Z SUB (Substitute) 58 3A : 90 5A Z 122 7A z 

27 1B ^[ ESC (Escape) 59 3B ; 91 5B [ 123 7B { 

28 1C ^\ FS  (File Separator) 60 3C < 92 5C \ 124 7C | 

29 1D ^] GS  (Group Separator) 61 3D = 93 5D ] 125 7D } 

30 1E ^^ RS  (Record Separator) 62 3E > 94 5E ^ 126 7E ~ 

31 1F ^_ US  (Unit Separator) 63 3F ? 95 5F _ 127 7F (Delete) 
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Appendix C – Radix Conversion Charts 

 
Converting Hexadecimal to Decimal 
This chart shows the conversion between hex and decimal. 
 

    0   1   2   3   4   5   6   7   8   9   A   B   C   D   E   F 

0  000 001 002 003 004 005 006 007 008 009 010 011 012 013 014 015 

1  016 017 018 019 020 021 022 023 024 025 026 027 028 029 030 031 

2  032 033 034 035 036 037 038 039 040 041 042 043 044 045 046 047 

3  048 049 050 051 052 053 054 055 056 057 058 059 060 061 062 063 

4  064 065 066 067 068 069 070 071 072 073 074 075 076 077 078 079 

5  080 081 082 083 084 085 086 087 088 089 090 091 092 093 094 095 

6  096 097 098 099 100 101 102 103 104 105 106 107 108 109 110 111 

7  112 113 114 115 116 117 118 119 120 121 122 123 124 125 126 127 

8  128 129 130 131 132 133 134 135 136 137 138 139 140 141 142 143 

9  144 145 146 147 148 149 150 151 152 153 154 155 156 157 158 159 

A  160 161 162 163 164 165 166 167 168 169 170 171 172 173 174 175 

B  176 177 178 179 180 181 182 183 184 185 186 187 188 189 190 191 

C  192 193 194 195 196 197 198 199 200 201 202 203 204 205 206 207 

D  208 209 210 211 212 213 214 215 216 217 218 219 220 221 222 223 

E  224 225 226 227 228 229 230 231 232 233 234 235 236 237 238 239 

F  240 241 242 243 244 245 246 247 248 249 250 251 252 253 254 255 

 
Usage example: 
Hex 31 is equivalent to decimal 49. Alternatively decimal 255 is equivalent to hex FF. 
 
Converting Hexadecimal to Octal 
This chart shows the conversion between hex and octal 
 
    0   1   2   3   4   5   6   7   8   9   A   B   C   D   E   F 

0  000 001 002 003 004 005 006 007 010 011 012 013 014 015 016 017 

1  020 021 022 023 024 025 026 027 030 031 032 033 034 035 036 037 

2  040 041 042 043 044 045 046 047 050 051 052 053 054 055 056 057 

3  060 061 062 063 064 065 066 067 070 071 072 073 074 075 076 077 

4  100 101 102 103 104 105 106 107 110 111 112 113 114 115 116 117 

5  120 121 122 123 134 125 126 127 130 131 132 133 134 135 136 137 

6  140 141 142 143 144 145 146 147 150 151 152 153 154 155 156 157 

7  160 161 162 163 164 165 166 167 170 171 172 173 174 175 176 177 

8  200 201 202 203 204 205 206 207 210 211 212 213 214 215 216 217 

9  220 221 222 223 224 225 226 227 230 231 232 233 234 235 236 237 

A  240 241 242 243 244 245 246 247 250 251 252 253 254 255 256 257 

B  260 261 262 263 264 265 266 267 270 271 272 273 274 275 276 277 

C  300 301 302 303 304 305 306 307 310 311 312 313 314 315 316 317 

D  320 321 322 323 324 325 326 327 330 331 332 333 334 335 336 337 

E  340 341 342 343 344 345 346 347 350 351 352 353 354 355 356 357 

F  360 361 362 363 364 365 366 367 370 371 372 373 374 375 376 377 

 

Usage example: 
Hex 7F is equivalent to octal 367. Alternatively octal 377 is equivalent to Hex FF. 
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Appendix D – Pinout and Signals for the PC RS232 Connector 

DB9 RS232 Port (IBM PC XT/AT) 
 
 
                           DB9 pin D-SUB male 
 
 
Pin Signal Name   Direction (DTE ← DCE) 
1 CD (Carrier Detect)  ← 
2 RXD (Receive Data)  ← 
3 TXD (Transmit Data)  → 
4 DTR (Data Terminal Ready) → 
5 GND (System Ground)   - 
6 DSR (Data Set Ready)  ← 
7 RTS (Request to Send)  → 
8 CTS (Clear to Send)  ← 
9 RI (Ring Indicator)  ← 

 
Note: a) Signal names are with respect to the computer/PC. b) Direction is from 
peripheral/modem (DCE) to the computer (DTE) e.g. RXD is the computer’s input pin. 
 

DB25 RS232 Port 

 
 
                                                 DB25 pin D-SUB male 
 
 
Pin Signal Name      Direction (DTE ← DCE) 
1 SHIELD (Shield/Protective Ground)    - 
2 TXD (Transmit Data)      → 
3 RXD (Receive Data)     ←       
4 RTS (Request to Send)     →    
5 CTS (Clear to Send)     ←        
6 DSR (Data Set Ready)     ←       
7 GND (System Ground)            - 
8 CD (Carrier Detect)     ←        
9 n/c        -                      
10 n/c        -                      
11 n/c        -                      
12 n/c        -                      
13 n/c        -                      
14 n/c        -                      
15 n/c        -                      
16 n/c        -                      
17 n/c        -                      
18 n/c        -                      
19 n/c        -                      
20 DTR (Data Terminal Ready)     → 
21 n/c        -                                           
22 RI (Ring Indicator)     ←         
23 n/c        -                                           
24 n/c        -                                           
25 n/c        -                                     
 
Note: a) Signal names are with respect to the computer/PC. b) Direction is from 
peripheral/modem (DCE) to the computer (DTE) e.g. RXD is the computer’s input pin. 
c) Do not connect SHIELD(1) to GND(7). 



 
 

  

SSiimmpplleeTTeerrmm  ––  UUsseerr  GGuuiiddee  
 
 

SimpleTerm Manual v3.2.doc, © Copyright 2022 Tronisoft - Printed in England, UK - All Rights Reserved. 43 

DB9-F (DEVICE B) DB9-M (DEVICE A) 
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Pin 1 
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Pin 7 
 
Pin 8 
 
Pin 9 

D1, D2 (1N4148) 

CON B 
 

Pin 1 
 
Pin 2 
 
Pin 3 
 
Pin 4 
 
Pin 5 
 
Pin 6 
 
Pin 7 
 
Pin 8 
 
Pin 9 

DB9-F (to PC e.g. COM1) 
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Appendix E – SimpleTerm Half Duplex Monitoring Cable 

SimpleTerm may be used as a low cost half duplex RS232 data monitor with the addition of 
some minimal external hardware. Two devices that take turns sending data are said to be 
communicating in "half duplex" mode. See Figure C1 below for the pass through hardware 
required. 
  
With this straightforward pass through arrangement, DEVICE A will still communicate with 
DEVICE B and vice versa but the communication (if half-duplex) may be monitored via a 
connection to the PCs serial port. 
 
 

Figure C1: Half Duplex Monitoring Adaptor / Cable 
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